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  A     MODELLEME 
 

A1                                       Keypointlerin oluşturulması: 
 
 
 
 
 
 
Main Menü>Preprocessor>Modeling>Create> 
Keypoints 

 
 
 

 
Biz bu keypointleri kullanarak Ansys sayfasında 
noktalar oluştururuz ve bu noktalar aracılığıyla 
çizgilerimizi , eğrilerimizi , alanlarımızı oluştura-
rak modellemenin ilk aşamasını gerçekleştirmiş 
oluruz.  

 
 
 
 
 
 
A.1.1  Çalışma düzlemi üzerinde rasgele keypoint oluşturma: 
 
 
>Preprocessor>Modeling>Create>Keypoints>
On Working Plane 
   

 
 

 
 

Çalışma düzlemi üzerinde keypointleri rasgele atamamızı 
 sağlar. Komutu girdiğimizde mausun sol tuşu ile 
istediğimiz yere tıklayıp “Ok” tuşuna basınca  keypointler 
oluşmuş olur.Bu bize ileride istenilen eğri formunu yaka- 
lamamızda yardımcı olur.Yandaki şekilde“1,2,3” no lu  
keypointler bu şekilde oluşturulmuştur. 



A.1.2  Çalışma düzlemi üzerinde koordinatları verilerek keypoint oluşturma: 
 

 
 

 
 
 
 
 

 
 
 
A.1.3 Bir çizgi üzerinde keypoint oluşturma: 
 
>Preprocessor>Modeling>Create>Keypoints>
On Line 
 

 
 

 
 

 
 
A.1.4 Bir çizgi üzerinde istenilen oranda keypoint oluşturma: 
 
 
>Preprocessor>Modeling>Create>Keypoints>
On Line w/Ratio 
 

 
 
 
 
 
 
 
 
 
 
 

 

>Preprocessor>Modeling>Create>Keypoints>
In Active CS 

http://www.batul.deu.edu.tr/...( 
Örneklerle ANSYS'e giriş) 
4. Bölümde anlatılmıştır. (Ctrl + sol tuşla 
tıklayıp girilebilir) 

Önceden çizilen bir çizgi üzerinde istenilen 
bir yere keypoint atamamızı sağlar.Komuta 
girdiğimizde üzerine keypointi yerleştire- 
ceğimiz çizgiyi seçeriz sonra “Apply” tu- 
şuna basıp çizgi üzerinde mausun sol tuşu 
ile  rasgele bir yeri tıklarız. “Ok” tuşuna 
basınca keypointimiz oluşmuş olur.Yanda- 
ki şekilde “3” no lu keypoint bu şekilde o- 
luşturulmuştur. 

Önceden çizilen bir çizgi üzerinde istenilen 
orana göre bir keypoint atamamızı sağlar. 
Komutu girdiğimizde üzerine keypointi 
yerleştireceğimiz çizgiyi seçeriz sonra 
“Apply” tuşuna basarız Karşımıza gelen 
menüde seçilen çizgiye hangi oranda ve  
hangi numaralı keypointi yerleştireceğimizi 
belirtip “Ok” tuşuna basarız.Yandaki 
şekilde “3”no lu keypoint bu şekilde oluş- 
turulmuştur. 



A.1.5 Düğüm noktası üzerinde keypoint oluşturma: 
 
>Preprocessor>Modeling>Create>Keypoints>
On Node 

 
Daha önceden oluşturulmuş bir düğüm noktası 
üzerine keypoint atamamızı sağlar.Komutu gir- 
diğimizde mausun sol tuşu ile düğüm noktaları- 
mızı seçerek “Ok” tuşuna basarız. Böylece key- 
pointlerimizi oluşturmuş oluruz Burada hem 
düğüm noktalarını hem de keypointleri aynı anda 
sayfa düzleminde göremeyiz.Yan tarafta bu şekilde 
oluşturulmuş keypointleri görüyoruz. 
  
 
A.1.6 İki keypoint arasına istenilen oran veya mesafede keypoint oluşturma: 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
A.1.7 İki keypoint arasına keypoint yerleştirme: 
 

 

 
 
 

 

>Preprocessor>Modeling>Create>Keypoints>
KP between KPs 

Seçilen iki keypoint arasına istenilen mesafe veya
oranda keypoint atar.Komuta girdiğimizde önce 
iki keypointi seçip “Apply” tuşuna basarız. 
Karşımıza gelen menüde ister istediğimiz oranı 
istersek de istediğimiz mesafeyi belirterek “Ok” 
tuşuna basarız Yandaki şekilde “1” no lu keypo- 
int bu şekilde oluşturulmuştur. 

>Preprocessor>Modeling>Create>Keypoints>
Fill between KPs 

Seçilen iki keypoint arasına istenilen sayıda 
keypoint atar.Komuta girip mausun sol tuşuyla
iki keypointi seçeriz ve “Apply” tuşuna basa- 
rız Karşımıza gelen menüde iki keypoint ara- 
sındaki yerleştireceğimiz keypointlerin sayısını 
ve numarasını girerek “Ok” tuşuna basarız. 
Yandaki şekilde “3” no lu keypointler bu şe- 
kilde oluşturulmuştur. 



 

A2                                                     Yayların oluşturulması: 
 
 
 
A.2.1         3 Noktadan geçen yayı oluşturma: 
 
>Preprocessor>Modeling>Create>Lines>Arcs>
Through 3 KPs 
 

Başlangıç , bitiş ve ara keypointler verilerek  
bir yay meydana getirilir. Komuta girdiğimiz- 
de daha önceden oluşturmuş olduğumuz 3 key-
pointten mausun sol tuşu ile sırasıyla başlangıç
bitiş ve orta keypointleri seçerek “Ok” tuşuna 
basarız.Böylece yay oluşmuş olur. 
 
 
 
 
 
 
A.2.2 Yay yarıçapı verilerek yay oluşturma: 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

>Preprocessor>Modeling>Create>Lines>Arcs>
By End KPs & Rad 

Başlangıç, bitiş ve yay merkezinin bulunduğu  
taraftan bir keypoint seçip yay yarıçapı 
verilerek yay çizimi gerçekleştirilir.Komuta  
girdiğimizde mausun sol tuşuyla başlangıç ve 
bitiş keypointleri seçilir ve “Apply” tuşuna  
basılır sonra yay merkezinin bulunduğu 
taraftan bir keypoint seçilerek yine “Apply” 
tuşuna basılır. Karşımıza gelen menüden yarı- 
çap değeri verilerek  “Ok” tuşuna basılır. 
Böylece yay oluşturulmuş olur. 



A.2.3 Merkez ve yarıçap verilerek istenilen açıda yay oluşturma: 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 

 
 

A.2.4 Merkez ve yarıçap verilerek daire oluşturma: 
 
 
 

>Preprocessor>Modeling>Create>Lines>Arcs>
Full Circle 
 
 
 
Merkez ve yarıçap keypointleri verilerek daire 
çizme komutudur.Komuta girildiğinde mausun 
sol tuşuyla merkez keypointi seçilip parmağı- 
mızı tuştan çekmeden yarıçap keypointi de se- 
çilir ve istenilen çapta daire çizilmiş olur. 

 
 
 

>Preprocessor>Modeling>Create>Lines>Arcs>
By Cent & Radius 

Merkez ve yarıçap keypointleri verilerek iste- 
nilen açı ve yay sayısında yay elde etme 
komutudur.Komuta girildiğinde mausun sol 
tuşuyla merkez keypointi seçilip parmağımızı  
tuştan çekmeden yarıçap keypointi de seçilir. 
Karşımıza  gelen menüde yayın başlangıç(0°)- 
bitiş açısı ile yay sayısı verilerek “Ok” tuşuna 
basılır.Böylece yay oluşturulmuş olur. 



A3                                          Eğrilerin oluşturulması: 
 
 
 
A.3.1 Başlangıç-bitiş ve ara keypointleri verilen bir eğrinin oluşturulması: 
 
>Preprocessor>Modeling>Create>Lines>Splines>
Spline thru Locs 
 
 
 
Başlangıç ve bitiş keypointleri verildikten sonra  
istenilen pozisyona göre ara keypointler de veri- 
lerek eğrimiz oluşturulur.Komuta girdikten sonra 
daha önceden oluşturmuş olduğumuz başlangıç 
ve bitiş keypointleri mausun sol tuşu ile 
işaretlenir ve “Apply” tuşuna basılır.Daha sonra 
yine mausun sol tuşu ile ara keypointler 
işaretlenir ve “Ok” tuşuna basılarak istenilen 
formda eğri oluşturulmuş olur. 

 
 
A.3.2  İstediğimiz forma göre işaretlenen keypointlerden eğrilerin oluşturulması: 
 
 

 
 

 
 
 
A.3.3 Bir eğri üzerine yeni bir eğrinin çizilmesi: 
 
 
>Preprocessor>Modeling>Create>Lines>Splines>
Segmented Spline 
 

 
Bir eğri üzerindeki ara ketpointleri kullanarak 
yeni bir eğri oluşturma komutudur.Komuta girildi- 
ğinde mausun sol tuşu ile daha önceden oluşturu- 
lan eğri üzerindeki keypointler istenilen forma 
göre seçilerek ikinci bir eğri oluşturulur. 

>Preprocessor>Modeling>Create>Lines>Splines>
Spline thru KPs 

Farklı pozisyonlardaki keypointler verilerek eğri 
oluşturma komutudur. Komuta girildikten sonra 
mausun sol tuşu ile daha önceden istediğimiz 
forma göre hazırladığımız keypointler işaretlenir 
ve “Ok” tuşuna basılarak eğri oluşturulur. 



 

A4                                             Alanların Oluşturulması: 
 
A.4.a Dikdörtgen alan oluşturulması: 
 
A.4.a.1 Herhangi bir köşesinin koordinatıyla genişlik ve yüksekliği verilen bir dikdörtgenin 
yaratılması: 
 
 
 
 

 

 
 
 
 

 
 

 
 
A.4.a.2 Merkez koordinatıyla genişlik ve yüksekliği verilen bir dikdörtgenin yaratılması: 
 
>Preprocessor>Modeling>Create>Areas> 
Rectangle>By Center & Corners 
 

 
 
 
 
 

A.4.a.3    Dikdörtgenin genişlik ve yüksekliği hangi X ve Y koordinatları arasında değiştiği                            
verilerek dikdörtgenin oluşturulması: 
 

 
 
 
  

>Preprocessor>Modeling>Create>Areas>
Rectangle>By 2 Corners 

Komuta girildiğinde ekranda bir menü açılır. 
Bu menüde oluşturulacak alanın merkez ko- 
ordinatları , genişlik ve yüksekliği girilir ve  
“Ok” tuşuna basılır.Böylece istenilen dik- 
dörtgen alan oluşturulmuş olur. 

http://www.batul.deu.edu.tr/...( 
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tıklayıp girilebilir) 

>Preprocessor>Modeling>Create>Areas> 
Rectangle>By Dimensions 

Komuta girildiğinde ekranda bir menü açılır. 
Bu menüde oluşturulacak alanın genişlik ve 
yüksekliğinin hangi X ve Y değerleri arasında 
değiştiği verilerek “Ok” tuşuna basılır.Böylece 
istenilen dikdörtgen alan oluşturulmuş olunur. 
 



A.4.b Daire alan oluşturulması: 
 
A.4.b.1 Merkez koordinatları ve yarıçapı verilen bir daireyi oluşturma: 
 

 

 
 

 
 
 
 
 
 
 
A.4.b.2 Merkez koordinatlarıyla iç ve dış yarıçapı verilen içi boş bir daireyi oluşturma: 
 
 

>Preprocessor>Modeling>Create>Areas> 
Circle>Annulus 

 
 

 
 
 
 
 
 
A.4.b.3  Merkez koordinatlarıyla iç ve dış yarıçapı ve başlangıç-bitiş açısı verilen içi boş bir 
daireyi oluşturma: 
 

 

>Preprocessor>Modeling>Create>Areas> 
Circle>Solid Circle 

Komuta girildiğinde ekranda bir menü 
açılır.Bu menüde oluşturulacak alanın 
merkez koordinatlarıyla yarıçapı verilir ve 
“Ok” tuşuna basılarak daire oluşturulur. 

  Komuta girildiğinde ekranda bir menü 
açılır.Bu menüde oluşturulacak alanın 
merkez koordinatlarıyla iç ve dış yarıçapı 
verilir ve“Ok” tuşuna basılarak daire 
oluşturulur. 

>Preprocessor>Modeling>Create>Areas> 
Circle>Partial Annulus 

Komuta girildiğinde ekranda bir menü 
açılır.Bu menüde oluşturulacak dairenin 
merkez koordinatlarıyla iç ve dış yarıçapı 
ve başlangıç-bitiş açısı verilir ve“Ok” 
tuşuna basılarak daire oluşturulur. 



 
A.4.b.4 Çap koordinatları verilen bir dairenin oluşturulması: 
 
 

 
 

 

 
 
 
 
 
 
 
 
A.4.b.5 Orjinde iç ve dış yarıçapı ile başlangıç-bitiş açısı verilen içi boş bir daireyi oluşturma: 
 
 

 
 
 

Komuta girildiğinde ekranda bir menü 
açılır.Bu menüde dairenin iç ve dış 
yarıçapları ile başlangıç ve bitiş açıları 
verilir ve“Ok” tuşuna basılarak daire 
oluşturulur.Burada daire orijine atanır. 

 
 
A.4.c Çokgen alan oluşturulması: 
 
A.4.c.1 Üçgenin oluşturulması: 
 

 
 

 
 

>Preprocessor>Modeling>Create>Areas> 
Circle>By End Point 

Komuta girildiğinde ekranda bir menü 
açılır.Bu menüde oluşturulacak dairenin 
çapının başlangıç-bitiş koordinatları verilir 
ve“Ok” tuşuna basılarak daire oluşturulur. 

>Preprocessor>Modeling>Create>Areas> 
Circle>By Dimensions 

>Preprocessor>Modeling>Create>Areas> 
Polygon>Triangle 

Komuta girildiğinde ekranda bir menü 
açılır. Bu menüde merkez koordinatları, 
dış çap ve dönme açısı verilir ve “Ok” 
tuşuna basılarak üçgen oluşturulur. 



A.4.c.2 Karenin oluşturulması: 
 
 

 

 
 
 
 
 
 
A.4.c.3 Beşgenin oluşturulması: 
 
 
 

 
 
 

 
 

 
 
 
 
A.4.c.4 Altıgenin oluşturulması: 
 
 

 
 
 

 
 
 
 
 
 

 

>Preprocessor>Modeling>Create>Areas> 
Polygon>Square 

Komuta girildiğinde ekranda bir menü açı- 
lır.Bu menüde karenin merkez koordinatı , 
 dış yarıçapı ve dönme açısı verilir.“Ok” 
tuşuna basılarak işlem gerçekleştirilir. 
 

>Preprocessor>Modeling>Create>Areas> 
Polygon>Pentagon 

Komuta girildiğinde ekranda bir menü açı- 
lır.Bu menüde beşgenin merkez koordinatı , 
 dış yarıçapı ve dönme açısı verilir.“Ok” 
tuşuna basılarak işlem gerçekleştirilir. 

>Preprocessor>Modeling>Create>Areas> 
Polygon>Hexagon 

Komuta girildiğinde ekranda bir menü açı- 
lır.Bu menüde altıgenin merkez koordinatı , 
 dış yarıçapı ve dönme açısı verilir.“Ok” 
tuşuna basılarak işlem gerçekleştirilir. 



A.4.c.5 Yedigenin oluşturulması: 
 
 
 

 

 

 
 
 
 
 
 
A.4.c.6 Sekizgenin oluşturulması: 
 
 
 

 
 

 
 
 
 
 
 
A.4.c.7 Orijinde iç yarıçapı ve kenar sayısı verilen çokgenin oluşturulması: 
 

 
 
 

 
 
 

 
 
 
 
 

Komuta girildiğinde ekranda bir menü açı- 
lır.Bu menüde yedigenin merkez koordinatı , 
 dış yarıçapı ve dönme açısı verilir.“Ok” 
tuşuna basılarak işlem gerçekleştirilir. 

>Preprocessor>Modeling>Create>Areas>
Polygon>Septagon 

>Preprocessor>Modeling>Create>Areas> 
Polygon>Octagon 

Komuta girildiğinde ekranda bir menü açılır. 
Bu menüde sekizgenin  merkez koordinatı, dış 
yarıçapı ve dönme açısı verilir.“Ok” tuşuna 
basılarak işlem gerçekleştirilir. 

>Preprocessor>Modeling>Create>Areas> 
Polygon>By Inscribed Rad 

Komuta girildiğinde ekranda bir menü açı- 
lır.Bu menüde çokgenin kenar sayısıyla iç 
yarıçapı verilir ve “Ok” tuşuna basılır. Böyle- 
ce orijinde bir çokgen oluşturmuş oluruz. 



A.4.c.8 Orijinde dış yarıçapı ve kenar sayısı verilen çokgenin oluşturulması: 
 

 
 
 
 

 
 
 
 
 

 
 
 

 
 
 

 
A.4.c.9 Orjinde kenar sayısı  ve kenar uzunluğu verilen çokgenin oluşturulması: 
 

 
 
 

 
A.4.c.10 Farklı formlarda çokgen oluşturma: 
 

>Preprocessor>Modeling>Create>Areas>
Polygon>By Vertices 

 
Diğer çokgenlere göre farklı formda, değişken 
kenar uzunluklarında ve kenar sayısında,iste- 
nilen konuma çokgen atamamızı sağlar. 
Komuta girdiğimizde mausun sol tuşuyla 
istediğimiz formda çizgiler oluştururuz ve 
“Ok” tuşuna basarız.Böylece çokgenimiz 
oluşur. 

>Preprocessor>Modeling>Create>Areas> 
Polygon>Circumscr Rad 

Komuta girildiğinde ekranda bir menü açı- 
lır.Bu menüde çokgenin kenar sayısıyla dış 
yarıçapı verilir ve “Ok” tuşuna basılır. Böyle- 
ce orijinde bir çokgen oluşturmuş oluruz. 

>Preprocessor>Modeling>Create>Areas> 
Polygon>By Side Length 

Komuta girildiğinde ekranda bir menü açı- 
lır.Bu menüde çokgenin kenar sayısıyla ke- 
nar  uzunluğu verilir ve “Ok” tuşuna basılır. 
Böylece orijinde bir çokgen oluşturmuş oluruz. 



 
A5                                                    Hacim oluşturma: 
 
 
A.5.a Alanlardan hacim oluşturma: 
 
A.5.a.1 Verilen bir alanı normali doğrultusunda uzatma: 
 
 
>Preprocessor>Modeling>Operate>Extrude>
Areas>Along Normal 

 
http://www.batul.deu.edu.tr/...( 
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A.5.a.2 Verilen bir alanı X,Y ve Z doğrultularında ve istenilen ölçekte uzatma: 
 
 
 
 
>Preprocessor>Modeling>Operate>Extrude> 
Areas>By XYZ Offset 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Komuta girdiğimizde mausun sol tuşuyla uzatıla- 
cak olan alanı seçeriz ve “Apply” tuşuna basarız. 
Karşımıza bir menü gelir.Bu menüde uzatılacak 
olan alanın hangi X,Y,Z mesafelerine kadar uza- 
tılacaksa o değerlerle o alanın istenilen doğrultu- 
daki büyüme ölçeği verilerek “Ok” tuşuna basa- 
rız. Böylece verdiğimiz alandan (A1) istediğimiz 
özelliklere sahip bir hacim oluşturmuş oluruz. 



A.5.a.3 Verilen bir alanın bir çizgi etrafında döndürerek katı oluşturma: 
 
 
 
>Preprocessor>Modeling>Operate>Extrude>
Areas>About Axis 
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A.5.a.4 Verilen bir alanı belirlenen bir çizgi doğrultusunda uzatma:  
 
 
 
 
>Preprocessor>Modeling>Operate>Extrude> 
Areas>Along Lines 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Komuta girdiğimizde mausun sol tuşuyla uzatıla- 
lacak olan alanı seçeriz ve “Apply” tuşuna basarız. 
Daha sonra hangi çizgi doğrultusunda alanımızı 
uzatacaksak o çizgiyi seçeriz ve “Ok” tuşuna basa- 
rız.Böylelikle istediğimiz özelliklere sahip bir katı 
oluşturmuş oluruz. 
 
 
 
 
 
 
 



A.5.b.Çizgilerden yüzey oluşturma: 
 
A.5.b.1 Dönel simetrik yüzey oluşturma: 
 
>Preprocessor>Modeling>Operate>Extrude>
Lines>About Axis 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
A.5.b.2 Düz yüzey oluşturma: 
 
>Preprocessor>Modeling>Operate>Extrude> 
Lines>Along Lines 
 
 
Komuta girildiğinde mausun sol tuşuyla yüzey 
oluşturulacak çizgi seçilir (L1) ve “Apply” tuşu- 
na basılır.Daha sonra o yüzeyi hangi doğrultuda  
uzatacaksak o doğrultudaki çizgi seçilir (L2) ve 
“Ok” tuşuna basılır.Böylece yüzeyimiz oluşmuş 
olur. 
 
 
 
 
 

Komuta girildiğinde mausun sol tuşuyla döndürü- 
lecek olan çizgiyi (L1) seçeriz ve “Apply” tuşuna  
basarız.Daha sonra bu çizgiyi hangi eksen etrafın- 
da döndüreceksek o ekseni iki keypointle belirtip 
(L2 çizgisinin başlangıç-bitiş keypointleri) “Ok” 
tuşuna basarız.Karşımıza gelen menüden döndür- 
me açısını belirterek dönel simetrik yüzeyimizi o- 
luşturmuş oluruz. 



 
A.5.c. .Keypointlerden çizgi oluşturma: 
 
A.5.c.1 Dönel simetrik çizgi oluşturma: 
 
 
>Preprocessor>Modeling>Operate>Extrude> 
Keypoints>About Axis 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 

 
 
 
 
 
 

A.5.c.2 Keypointler yardımıyla bir çizgiye paralel bir çizgi çizme: 
 
 
>Preprocessor>Modeling>Operate>Extrude> 
Keypoints>Along Lines 
 
 
Komuta girildiğinde mausun sol tuşuyla paralel 
çizilecek çizginin başlangıç keypointi seçilir (1 
no lu keypoint) ve“Apply” tuşuna basılır.Sonra  
paraleli çizilecek çizgi (L1) seçilir ve “Ok” tuşu- 
na basılır.Böylece bir çizgiye paralel atmış olu- 
ruz. 
 
 
 
 

Komuta girildiğinde döndürülecek olan keypointi 
(1 no lu keypoint) seçeriz ve “Apply” tuşuna basa- 
rız. Daha sonra hangi eksen etrafında döndürecek- 
sek o ekseni belirten başlangıç-bitiş keypointlerini  
seçerek (2 ve 3 no lu keypointler) “Ok” tuşuna ba- 
sarız. Karşımıza gelen menüden döndürme açısını 
da vererek dönel simetrik çizgimi oluşturmuş olu- 
ruz. 



A6                                      İki alanın kesişiminin alınması: 
 
 
 
 
>Preprocessor>Modeling>Operate>Booleans>
Intersect>Common>Areas 
 
 
Komuta girildiğinde kesişen iki alan mausun sol  
tuşuyla seçilir ve “Ok” tuşuna basılır. Böylece i- 
ki alanın kesişimi alınmış olur. 
 
 
 
 
 
 
 

A7                                         İki alanın birleşiminin alınması: 
 
 
>Preprocessor>Modeling>Operate>Booleans>
Add> Areas 
 
 

 
 
 
 

 
 
 
 
 
 
 

A8                                            İki alanın birbirinden çıkarılması: 
 
>Preprocessor>Modeling>Operate>Booleans>
Subtract>Areas 
 
http://www.batul.deu.edu.tr/...( 
Örneklerle ANSYS'e giriş) 
14. Bölümde anlatılmıştır. . (Ctrl + sol tuşla 
tıklayıp girilebilir) 
 

Komuta girildiğinde kesişen iki alan mausun sol  
tuşuyla seçilir ve “Ok” tuşuna basılır. Böylece i- 
ki alanın birleşimi alınmış olur.  



 

A9                                                          Alanların bölünmesi: 
 
A.9.a Bir alanın başka bir alan tarafından bölünmesi: 
 
 
 
>Preprocessor>Modeling>Operate>Booleans>
Divide>Area by Area 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
A.9.b Bir alanın bir çizgi tarafından bölünmesi.: 
 
 
>Preprocessor>Modeling>Operate>Booleans>
Divide>Area by Line 
 
 
Komuta girildiğinde mausun sol tuşuyla bölünecek 
olan alan seçilir (A1) ve “Apply” tuşuna basılır. 
Daha sonra alanımızı bölecek çizgiyi yine mausun  
sol tuşuyla seçeriz ve “Ok” tuşuna basarız.Böyle- 
likle alanımızı bir çizgi yardımıyla ikiye bölmüş  
oluruz. 

Komuta girildiğinde kesişen iki alandan bölü- 
necek olan alan (A2) seçilir ve “Apply” tuşuna 
basılır.Daha sonra bölünecek alanı hangi alan 
ile böleceksek o alan seçilir (A1) ve “Ok” tuşu- 
na basılır.Böylelikle alanımızı başka bir alan  
yardımıyla ikiye bölmüş oluruz.(A4 ve A3) 



 

A10                                             İki alanın yapıştırılması: 
 
 
>Preprocessor>Modeling>Operate>Booleans>
>Glue>Areas 
 
 
 
http://www.batul.deu.edu.tr/...( 
Örneklerle ANSYS'e giriş) 
8. Bölümde anlatılmıştır. . (Ctrl + sol tuşla 
tıklayıp girilebilir) 
 
 
 
 

A11                                           Verilen bir alanın ölçeğini değiştirme: 
 
 
 
 
>Preprocessor>Modeling>Operate>Scale> 
Areas 
 
 
 
 
 
 
 
 
 
Komuta girildiğinde mausun sol tuşuyla ölçeği 
değiştirilecek alanı seçeriz  (A1) ve “Apply” tu- 
şuna basarız.Sonra karşımıza gelen menüden bü- 
yültme ölçeğini belirtiriz ve “Ok” tuşuna basarız. 
Örneğimizde (A1) alanını iki katına çıkarttık. 
 
 
 
 
 
 
 
 
 
 



 

A12          Bir alanı bulunduğu koordinatlardan başka koordinatlara taşımak: 
 
 
>Preprocessor>Modeling>Move/Modify> 
Areas>Areas 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 

A13                                       Verilen bir alanı kopyalamak: 
 
 
>Preprocessor>Modeling>Copy>Areas 
 
 
 

 
 
 
 
 
 
 
 

Komuta girdiğimizde taşıyacağımız alanı (A1) 
mausun sol tuşuyla seçip “Apply” tuşuna basa- 
rız Karşımıza gelen menüden  taşıyacağımız 
mesafeyi belirtip “Ok” tuşuna basarız.Böylece 
alanımızın koordinatlarını değiştirmiş oluruz. 

Komuta girdiğimizde kopyala cağımız alanı (A1) 
mausun sol tuşuyla seçip “Apply” tuşuna basa- 
rız Karşımıza gelen menüden  X,Y ve Z eksenle- 
rindeki kopya sayısının kaç tane olduğunu ve iki 
kopya arası mesafenin ne kadar olduğunu belirtip 
“Ok” tuşuna basarız.Böylelikle kopya alanlarımı- 
zı oluşturmuş oluruz. 



A14                                      Verilen bir alanı aynalamak: 
 
 
 
 
>Preprocessor>Modeling>Reflect>Areas 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
NOT: Buraya kadar anlatılan alanları içeren tüm komutlar aynı şekilde hacimler içinde 
uygulanabilir.Komutların işlevsellik özelliği her ikisinde de aynıdır. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Komuta girdiğimizde aynalayacağımız alanı (A1) 
mausun sol tuşuyla seçip “Apply” tuşuna basa- 
rız Karşımıza gelen menüden  aynalamayı hangi 
eksene göre yapacağımızı belirtip “Ok” tuşuna 
basarız.Böylelikle aynalama alanımızı oluşturmuş 
oluruz. 



 

A15   Üç boyutlu geometrisi düzgün olmayan bir katı model oluşturma: 
 
 
A.15.a Keypointlerin oluşturulması: 
 
>Preprocessor>Modeling>Create>Keypoints>
İn Active CS 
 
 
 
Üç boyutlu karmaşık bir şekil oluşturmada ilk 
aşama keypoint oluşturmaktır.Biz aşağıdaki 
örneğimizde sırasıyla keypointlerimizi oluşturup 
bu keypointlerden eğriler elde edeceğiz. 
 
 
 
 K1 K2 K3 K4 K5 K6 K7 K8 K9 K10 K11 K12 
X 50 43 37 35 30 22 13 14 16 18 26 40 
Y 30 20 3 -15 -9 -3 0 10 28 40 34 28 
Z 20 15 8 -5 -3 -1 0 7 18 30 23 22 
 
 
 
A.15.b Keypointlerden eğriler elde etme: 
 
 
 
>Preprocessor>Modeling>Create>Lines>
Splines>Spline thru KPs 
 
 
Komuta girdiğimizde daha önceden oluturmuş 
olduğumuz keypointleri mausun sol tuşuyla 
sırasıyla seçeriz ve “Ok” tuşuna basarız.Örne- 
ğimizdeki eğrileride bu şekilde oluşturuyoruz. 
Fakat burada her 4 keypointi seçtikten sonra 
“Apply” tuşuna basıyoruz.Çünkü 4 keypointten 
bir eğri oluşuyormuş gibi kabul ettik.Bu sayı 2 
den başlayıp sonsuza kadar devam eder.Dikkat 
ederseniz son oluşturduğumuz eğri ile ilk oluş- 
turduğumuz eğri birbirini tamamlıyor.Bunu  
eğrilerden kapalı bir alan oluşturmak için 
yaptık. 
 
 
 
 



A.15.c Eğrilerden alan elde etme: 
 
>Preprocessor>Modeling>Create>Areas> 
Arbitrary>By Lines 
 
 
Komuta girdiğimizde daha önceden oluşturmuş 
olduğumuz eğrileri mausun sol tuşuyla seçeriz 
ve “Ok” tuşuna basarız. Örneğimizdeki alan da 
 bu şekilde oluşturulmuştur.Burada önemli olan
bir düzlem içerisinde bulunmayan bu tip bir 
alan maksimum 4 eğriden oluşabilir. 
 
 
 
A.15.d Alanlardan hacim oluşturma: 
 
 
Bu komutun işlevselliğini gösterebilmek için hacmi oluşturacak alanların kapalı bir şekli 
teşkil etmesi gerekir.Bunun için örneğimizde 5 tane birbiriyle bağıntılı alan oluşturup 
bunlardan bir hacim oluşturmaya çalışalım.Bunu için yeni keypointler tanımlayıp bunlardan 
eğriler, eğrilerden de alanlar elde etmeye çalışalım. 
 
 K13 K14 K15 K16 K17 K18 K19 K20 K21 K22 K23 K24 K25 K26
X 45 37 30 28 23 34 33 15 13,5 14 20 25 17 16 
Y 20 10 5 10 30 -10 -2 20 5 15 12 8 35 25 
Z 35 55 70 60 45 25 45 50 15 35 55 65 35 45 
 
 
Öncelikle 1,13,14,15 no lu keypointlerle10,17,16,15 
no lu keypointlerden iki eğri oluşturup bu iki eğriyi 
kapalı bir alana teşkil eden eğriyle (10,11,12,1 nolu 
keypointlerden oluşan eğri) birleştirip alan oluştura-
lım. 
 
 
 
 
 
 
 
 
 
 
 
Şimdide 4,18,19,15 no lu keypointlerle bir eğri 
oluşturup bu eğriyi kapalı bir alana teşkil eden 
(1,2,3,4 no lu keypointlerle oluşan eğri ile 
1,13,14,15 no lu keypointlerle oluşan eğri) eğ- 
rilerle birleştirip alan oluşturalım. 



 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
Görüldüğü gibi son alanlarımızı oluşturduktan sonra kapalı bir şekil elde ediyoruz.Bu 
kapalı şekil halen bir alandır.Biz bu kapalı şekli hacim yaparak  modellememizin son 
aşamasını gerçekleştirmiş oluruz. 
 
 
 
 
 
 
>Preprocessor>Modeling>Create>Volumes> 
Arbitrary>By Areas 
 
 
 
Komuta girdiğimizde tüm alanları seçip “Ok” 
tuşuna basarız.Böylelikle istediğimiz hacmi elde  
etmiş oluruz. 
 
 

Daha sonra 7,21,22,20 no lu keypointlerle 20,23, 
24,15 no lu keypointlerden iki eğri oluşturup bu 
iki eğriyi kapalı bir alana teşkil eden eğrilerle 
(5,6,7,8 no lu keypointlerle oluşan eğri ile 4,18, 
19,15 no lu keypointlerle oluşan eğri) birleştirip 
alan oluşturalım. 

En son olarak 10,25,26,20 no lu keypointlerle bir eğri 
oluşturup bu eğriyi kapalı iki alana teşkil eden 
(10,17,16,15 ve 20,23,24,15 no lu keypointlerden 
oluşan eğrilerle 7,21,22,20 ve 7,8,9,10 no lu keypo- 
intlerden oluşan eğriler) eğrilerle birleştirip alan 
oluşturalım.  



B         SONUÇLARIN DEĞERLENDİRİLMESİ 
 
 

B16               Bir bölgedeki bir sonucun dağılımını daha hassas aralıklarla görme: 
 
 

PlotCtrls>Style>Contours>Uniform Contours… 
 
 

Komuta girildiğinde ekranda bir menü açılır.Menüye 
girdiğimizde öncelikle “User specified” kısmını işa- 
retleriz.Daha sonra örneğin gerilme dağılımı ekranda 
görülen modelin hangi bölgesinin gerilmelerini daha 
ayrıntılı olarak görmek istiyorsak o bölgenin ekranın 
altında belirtilen max-min gerilme aralığı değerlerini 
(VMIN-VMAX) menüde belirtiriz ve “Apply” 
tuşuna basarız.En son olarak “Auto calculated ” 
kısmını işaretleyerek komuttan çıkarız.Böylelikle bir 
parçadaki gerilme dağılımını daha hassas aralıklarla 
incelemiş oluruz.Bu işlem diğer sonuçlar içinde ya- 
pılabilir. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

B17         Tanımlanan bir yörünge (path) boyunca sonuç dağılımlarını çizdirme: 
 
 
 
B.17.a Yörüngeyi oluşturma: 
 
 
Main Menü>General Postprocessor>Path 
Operations>Define Path>By Nodes 
 
 
Komuta girildiğinde ekranda bir menü açılır. 
Mausun sol tuşuyla çözümü yapılan modelimizin 
değerlendirme aşamasında modelde düşünülen  
yörüngeyi,  bu yörünge üzerinde mevcut olan 
düğümlerle (node larla), bu düğümleri düzgün 
sırayla seçerek oluştururuz ve “Ok” tuşuna 
basarız. Karşımıza bir menü gelir. 
Bu menüde “Define Path Name” kısmından bu 
yörünge ismini tanımlarız ve “Ok” tuşuna basa- 
rız.Böylelikle ismini vermiş olduğumuz bir yö- 
rüngeyi oluşturmuş oluruz. 
 
 
 
 
 
 
 
 
 
 
 
 
 
B.17.b Yörüngeye istenilen sonuç türünü atamak: 
 
Main Menü>General Postprocessor>Path 
Operations>Map onto Path 
 
Komuta girildiğinde ekranda bir menü açılır.Menü- 
de “User label for item” kısmından oluşturduğumuz 
yörünge ismini gireriz ve grafik üzerinde hangi so- 
nuç dağılımını (örneğin SY gerilmelerini) görmek 
istiyorsak onu seçeriz En son olarak “Ok” tuşuna 
basarız.Böylelikle yörüngemize bir sonuç atamış 
oluruz. 



 
B.17.c Yörünge üzerindeki gerilme dağılımlarını grafik üzerinde görme: 
 
Main Menü>General Postprocessor>Path 
Operations>Plot Path Item>On Graph 
 
 
Komuta girildiğinde ekranda bir menü açılır.Menü- 
de daha önceden oluşturmuş  olduğumuz   yörünge 
ismini seçeriz ve “Ok”  tuşuna  basarız.  Böylelikle 
oluşturduğumuz yörünge üzerindeki  gerilme  dağı- 
lımlarını grafik üzerinde görmüş oluruz.Aynı yörün- 
ge üzerinde atanmış birden fazla sonuç varsa 
işaretlenerek aynı grafik üzerinde görülebilir. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



B18        Bir sonucun değerlerini parçanın kesit görünüşünden bakarak görme: 
 
 
 

Plot Ctrls>Style>Hidden Line Options… 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 

 

Komuta girildiğinde ekranda bir menü açılır.Menü- 
de “Type of Plot” kısmından Capped hidden ve “Cut- 
ting plane is ” kısmından da Working Plane işaretlenip 
“Ok” tuşuna basılır. Böylece parçamızdaki bir sonuç 
dağılımını parçamızın kesit görünüşünden bakarak 
görmüş oluruz.Biz burada örnek olarak 27. bölümden 
başlayıp 37. bölümde biten üç boyutlu zamana bağlı 
olmayan sıcaklık analizini (bakınız: 
http://www.batul.deu.edu.tr/.Örneklerle ANSYS'e 
giriş)  
kullandık.Ayrıca workplane i  6 nolu keypointin 
üzeri(Workplane>Ofset WP to>Keypoints + >Mausun 
sol tuşu ile 6 nolu key-pointi seç) atadık.  
     Kesit alınacak düzlem mutlaka WX-WY düzlemi 
olmalıdır.  Bu nedenle başka kesitler için Working Plane 
uygun bir Keypoint’e taşınarak ve döndürülerek bu 
durum sağlanmalıdır. Bu işlem ise Örneklerle Ansys’e 
giriş kısmının i-21, i-23 adımlarında anlatılmıştır.  



C    EKRAN ÖZELLİKLERİ 
 
C19                            Ekrandaki bir parçanın görüntüsel özellikleri: 
 
 
 
C.19.a Parçaya verilen bir koordinat doğrultusundan veya herhangi bir eksenden bakma: 
 
 
Utility Menü>PlotCtrls>View Settings> 
Viewing Direction 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
C.19.b Parçayı verilen bir açı değerinde döndürme: 
 
 
PlotCtrls>View Settings>Angle of Rotation 
 
 
Komuta girildiğinde ekranda bir menü açılır. 
Menüde parçayı hangi derecede döndüreceksek 
o değerle hangi eksen etrafında döndüreceksek 
o eksen girilerek “Ok” tuşuna basılır.Böylece 
parçamızı istediğimiz açı ve eksen doğrultu- 
sunda döndürmüş oluruz. 
 
 
 
 
 

Komuta girildiğinde ekranda bir menü açılır. 
Menüde parçaya hangi bakış noktasının koor- 
dinatında bakacaksak o koordinat ve hangi  
eksen doğrultusunda bakacaksak o eksen gi- 
rilir ve “Ok” tuşuna basılır.Böylece parçamı- 
zı istediğimiz doğrultuda görebilme imkanı- 
na erişiriz. 



 
C.19.c Parçanın ekrandaki büyüklüğünü değiştirme: 
 
 
PlotCtrls>View Settings>Magnification 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
C.19.d Parçaya verdiğin koordinatı ekranın merkezi olarak kabul edip bakma: 
 
 
PlotCtrls>View Settings>Focus Point 
 
 
 

 
 
 
 
 
 

Komuta girildiğinde ekranda bir meni açılır. 
Menüde kendi büyültme mesafemizi verebil- 
mek için öncelikle “User Specified” kısmını 
tıklamalı ve sonrada büyültme mesafemizi ver- 
meliyiz.Böylece parçamızın büyüklüğünü de- 
ğiştiririz. 

Komuta girildiğinde ekranda bir meni açılır. 
Menüde parçaya kendi verdiğimiz bir koordina- 
tı ekran merkezi kabul edip bakabilmemiz için ön- 
likle “User Specified” kısmı tıklanmalı sonra da 
koordinat değeri girilmelidir.Böylelikle parçaya  
istediğimiz koordinat değerini ekran merkezi ola- 
rak kabul edip bakarız. 



 
C.19.e Parçadaki görünmez çizgileri görme: 
 
 
PlotCtrls>Style>Hidden Line Options… 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
  
 
 
 
 
 
C.19.f Parçanın her bir kısmının ekrandaki büyüklüğünü merkezleri doğrultusunda 
değiştirme: 
 
PlotCtrls>Style>Size and Shape 
 
 
Komuta girildiğinde ekranda bir meni açılır. 
Menüde girildiğinde“Shrink entities by” kıs- 
mına bir küçültme oranı verilir ve “Ok” tuşu- 
na basılır.Böylece ekrandaki parçanın her bir 
kısmı kendi merkezi doğrultusunda verilen  
küçültme oranı ile küçülür. 
 
 
 
 
 
 
 
 

Komuta girildiğinde ekranda bir menü açılır. 
Menüde parçaya pan-zoom-rotate komutu  
yardımıyla baktığımız bir bakış açısından ba- 
karak istediğimiz görüntüsel görünümlerini  
“ Type of Plot” kısmından ayarlarız ve “Ok” 
tuşuna basarız. Böylece parçadaki görünmez 
çizgileri görmüş oluruz. 



 
  

  C20               Ekrandaki renk değişimleri: 
 

 
C.20.a.Ekranın zemin rengini tersine çevirme: 
 
 
 
 
PlotCtrls>Style>Colors>Reverse Video 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
C.20.b.Ekrandaki parçanın her bir bölümünün rengini ayrı ayrı değiştirme:   
 
 
 
PlotCtrls>Style>Colors>Numbered Item Colors 
 
 
Komuta girildiğinde ekranda bir menü açılır.Menü- 
de her bir alan numarasına göre rengi değiştirilir ve 
“Ok” tuşuna basılır.Böylece istediğimiz bir alanın 
rengini değiştirmiş oluruz. 
 
 
 

 
 
 
 
 
 
 
 

Komuta girildiğinde direkt olarak ekranın 
zemin rengi tersine çevrilir. 



 
C.20.c Ekrandaki pencerenin rengini tersine 
çevirme: 
 
 
 
PlotCtrls>Style>Colors>Windows Colors… 
 
 
Komuta girildiğinde ekranda bir menü açılır.Menü 
de “Background of Windows 1” kısmından bir 
renk seçerek “Ok” tuşuna basarız.Böylece ekranı- 
mızın rengini seçtiğimiz renge çevirmiş oluruz. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
C.20.d.Ekran zemin rengini değiştirme: 
 
 
PlotCtrls>Style>Background> 
Shaded Background 
 

 

 
 

Komuta girildiğinde ekranda bir menü açılır.Menü- 
de “Color” kısmından ekranın zemin rengini, “Style” 
kısmından da ekran gölgeliğinin yerini belirterek 
“Ok” tuşuna basarız. Böylece ekranımızın zemin 
rengini değiştirmiş oluruz.Yalnız bu komutun 
işlevselliğini yerine getirebilmesi için 
PlotCtrls>Style>Background>Display Picture 
Background kısmının tıklanmış olması gerekir. 



 

C21                         Ekrandaki konumsal değişiklikler: 
C.21.a Konturun pozisyonunun değiştirilmesi: 
 
PlotCtrls>Style>Multilegend Options> 
Contour Legend… 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
  
 
 
 
 
 
 
 
 
 
C.21.b.Ekrandaki bilgisel yazıların konumunun değiştirilmesi: 
 
 
PlotCtrls>Style>Multilegend Options> 
Text Legend… 
 
 

 
 
 

Komuta girildiğinde ekranda bir menü açılır.Menü- 
de “Location” kısmından konturu nereye yerleşti- 
receksek onu belirtiriz ve “Ok” tuşuna basarız. 
Böylece konturumuzun pozisyonunu ekran üzerin- 
de değiştirmiş oluruz. 

Komuta girildiğinde ekranda bir menü açılır.Menü- 
de ekrandaki bilgisel yazıların “Type Info,Date” gibi 
konumunu “Location” kısmından değiştirip “Ok” tu- 
şuna basarız Böylece ekrandaki bilgisel yazıların ko- 
numunu değiştirmiş oluruz. Örneğimizde tarih gös- 
tergesini ekrandan kaldırmış olduk. 



C22         Bir katıya tel kafes görünümünde bakma: 
 
 
PlotCtrls>Style>Solid Model Facets… 

 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

C23     Ekranda yazılan yazıların yazı tipini değiştirme: 
 
C.23.a Ekrandaki bilgisel yazıların yazı tipini değiştirme: 
 
PlotCtrls>Font Controls>Legend Font… 
 
 
Komuta girildiğinde ekranda bir menü açılır.Menü- 
de isteğimize göre “Yazı tipi, Yazı tipi stili ve boyut” 
değiştirilir ve “Ok” tuşuna basılır. Böylece ekrandaki 
bilgisel yazıların yazı tipi değiştirilmiş olur. 
 

 
 
 
 
 

Komuta girildiğinde ekranda bir menü açılır.Menü- 
de  “Style of area and volume plots” kısmından ka- 
tının tel kafes (Wireframe) görünümüne geçilir ve 
“Ok” tuşuna basılır. Böylece katımıza tel kafes gö- 
rünümüyle bakmış oluruz. 



C.23.b Ekrandaki nesnelerin numaralarının yazı tipini değiştirme: 
 
 
PlotCtrls>Font Controls>Entity Font… 
 
 
Komuta girildiğinde ekranda bir menü açılır.Menü- 
de isteğimize göre“Yazı tipi, Yazı tipi stili ve boyut” 
değiştirilir ve “Ok” tuşuna basılır. Böylece ekrandaki
nesnelerin numaralarının yazı tipini değiştirmiş olu- 
ruz 
 
 
 
 
 
 
 
 
 
 
 
 

C24                                 Ölçülendirme: 
 
 
PlotCtrls>Annotation>Create 2D  Annotation 
 
 
 
 
 
 

 
 

 

Komuta girildiğinde ekranda bir menü açılır.Menü- 
de hangi pozisyonlarda ölçülendirme yapacağımız , 
ölçülendirme rengi ve ölçülendirme yazısının nasıl 
yapıldığı seçilir ve “Ok” tuşuna basılır.Mesela yatay 
doğrultuda ölçülendirme yapacaksak menüden “Ho- 
rizantal” ve  “Inline Text” kısımları , dikey doğrul- 
tuda ölçülendirme yapacaksak “Vertical” ve “Paral- 
lel Text” kısımları tıklanır ve mausun sol tuşuyla  
ölçülendirme yapacağımız çizginin başlangıç ve bitiş 
keypointleri tıklanarak ölçülendirme çizgisi çizilir. 
Sonra klavyeden ölçülendirme yazısı yazılır ve “En- 
ter” tuşuna basılır.Böylelikle istediğimiz yerdeki öl- 
çülendirme işlemini gerçekleştirmiş oluruz.Yalnız 
burada unutulmaması gereken ölçülendirme istediği- 
miz rakamda verilir. 



C25               Ekrandaki parçanın fotoğrafını çekme: 
 
C.25.a Ekrandaki parçanın fotoğrafını dosyanın çalışıldığı yere 
çekme: 
 
PlotCtrls>Hard Copy>To File… 
 
Komuta girildiğinde ekranda bir menü açılır.Menü- 
de “Ok” tuşuna basarız.Böylelikle çalıştığımız dos- 
yanın bulunduğu yere ekran üzerindeki parçamızın  
fotoğrafını çekmiş oluruz. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
C.25.b Ekrandaki parçanın fotoğrafını printıra gönderme: 
 
 
PlotCtrls>Hard Copy>To Printer… 
 
 
Komuta girildiğinde ekranda bir menü açılır.Menü- 
de kullandığımız yazıcının tipini belirtip  “yazdır” 
butonuna basarız.Böylelikle parçamızın resmi prin- 
tıra gönderilmiş olur. 
 
 
 
 
 



C.25.c Ekrandaki parçanın fotoğrafını ekran 
üzerinde çekme: 
 
 
PlotCtrls>Capture Image… 
 

 
 
 
 
 
 
 
 
 
C.25.d Daha önceden fotoğrafı çekilmiş bir parçanın fotoğrafını ekran üzerine çağırma: 
 
 
PlotCtrls>Restore Image… 
 
 
Komuta girdiğimizde daha önceden fotoğrafı 
çekilmiş olan resimler “Restore Bitmap From” 
menüsünde karşımıza çıkar.İstediğimiz bir ta- 
nesini seçip  “Aç” tuşuna basarız.Böylelikle 
önceden fotoğrafı çekilmiş bir parçanın fotoğ- 
rafını ekran üzerine çağırmış oluruz. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Komuta girildiğinde doğrudan ekran üzerinde  
çalışma parçasının fotoğrafı çekilmiş olur. 


